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Some unsolicited comments about the TimeTabler programs:
“A very powerful and useful set of programs” - Timetabler in Lancashire
“Options is just excellent . . . it did all I asked . . . in an easy and friendly way” - Wales
“. . . maintains the high standards you have set in terms of software that really does the job that schools
want and need” - Cheshire
“I have just completed the transfer of the finished timetable from TimeTabler directly into SIMS .net.
Your documentation was clear and logical, and I had no problems completing the transfer.” - Yorkshire
“ . . . your excellent timetabling programs” - Northern Ireland
“ TimeTabler halved the time to prepare our timetable” - London
“ . . . . . great respect for a marvellous piece of programming” - Scotland
“Options continues to provide a real solution to an annual issue. We are delighted with the flexibility
and adaptability of the software.” - London
“Thanks for all your help . . . . a superb suite of programs” - Wales

“Many thanks for your help . . . The email support you have offered has been great ” - Australia
“Congratulations on a great piece of software . . . keep up the innovations ” - Malaysia
“Options is as terrific as TimeTabler . . . it is user-friendly, fast and efficient. It saved me hours.” - Lancs
“Like your book on Timetabling, we have found it invaluable in our school” - Eire
“I am really pleased with the Options package, it has saved me hours of work.”

- Middlesex ”

“The TimeTabler program is the easiest and most versatile I have used and I have tried most of them.
For the timetabler it is a dream; easy to understand and works exactly to timetabling best practice.
Set it up and it will deliver a real quality timetable.” - Lancashire
“ . . . a delight to work with . . . I am extremely grateful to you for producing it”

- Staffordshire

“Our timetable exported first time into SIMS.net with your excellent Export Wizard. That was brilliant!”
- Somerset
“I am very impressed . . . StaffCover is of the same excellent quality as TimeTabler” - Wales

“ Our existing columns only gave them 50% pupil satisfaction, whilst with Options I was very quickly
able to improve that to only 1 pupil not getting exactly what he wanted.” - Oxfordshire
“Many thanks . . . . we are delighted . . . . you are saving us hours” - Shropshire
“I found TimeTabler much easier to use than the one offered by my school system.” - Surrey
“Options. Superb!! What a time-saver!!” - Scotland
“Many thanks for an excellent package” - Scotland
“Brilliant program ! Its power far exceeds any other timetabling software I’ve tried” - Wales
“ . . . a godsend . . . your program is far better than others costing considerably more” - Australia
Many more comments and testimonials at: http://www.timetabler.com/comments.html
Options Manual
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Introduction
Arranging the optional part of the school or college curriculum into a suitable pattern
can be a challenge.
Often this is the most complex part of your curriculum, requiring a careful balance so
as to offer a wide choice without using too many expensive staffing resources.
The ideal curriculum will offer the students all the choices they wish for, and achieving
this can be a valuable motivator, perhaps leading to a better ethos and better
examination results.
It can also be important for public relations with the parents.
At the same time the cost of staffing extra groups is very high, and it is important to
find an efficient pattern of subjects that can be staffed within budget.
Using a paper system to find the best arrangement can be a daunting task.
Options can quickly cut down the laborious aspects, while still allowing you to use
your skill and judgement in knowing what is best for the students, and the school.
This is the value of Options. We hope you enjoy using it.

Chris Johnson
Keith Johnson
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An Outline of Options
This Options program helps you to deal quickly and effectively with a common situation in
schools & colleges, when students are given some Choice in the subjects they wish to study.
In UK schools and colleges it occurs typically:

•

at the end of Year 9 (Grade 9, S2) when students are asked to choose which subjects they
wish to study in Year 10 (eg. for GCSE, BTEC, 14-19 Diplomas or National exams),

•

at the end of Year 11 (Grade 11, S4) when students are asked to choose which subjects
they wish to study in Year 12 (the ‘Sixth Form’) (eg. for AS, A-level, IB, Highers).

Typically, students are given a list of possible subjects, and asked to choose a specific number
of subjects (for example, four, perhaps with a extra ‘reserve’ choice).
Often there will be rules attached: eg. “You must study at least one science”.
The students/parents can indicate their Choices on paper, or they can enter them on the internet
from home, using the TOOLS system.
The intention is then to arrange the subjects in an appropriate pattern so that it can be
scheduled as a timetable that will suit this particular group of students and their choices.

When all the Choices are collected in from the students, it is then the task, usually of a
Senior Member of Staff, to organise the subjects or ‘electives’ into Option ‘Blocks’.
These ‘Blocks’ are also called ‘Pools’ or ‘Columns’ or ‘Lines’, or given names like ‘Option B’.
Each Block is a set of subjects which are to be scheduled at the same time on the timetable.
This means a student can normally study only one subject in each Block.
In some year-groups (eg. Year 12) some students may study subjects in only some of the
Blocks, being ‘free’ or having ‘private study periods’ at other times.

It is important to organise this arrangement as efficiently as possible..
The aims are:

•

To achieve the maximum ‘Satisfaction Rate’ for the students.
ie. with the maximum number of students getting their chosen subjects.
This is important for students and parents, and can affect the ethos of the school or college.

•

To use the minimum number of groups consistent with good teaching practice.
ie. to keep the cost of staffing the curriculum as low as possible.
This can make a big difference to the school budget.

This is where the power of the Options program shows itself.
Options helps you to deal speedily and efficiently with the Students’ Choices in order to
develop the best Option Block Pattern to suit these particular students and your staffing.
The Tutorial shows you how.

Options will run on any PC computer running Windows XP, Vista, 7, 8, 10, or later.
(It can be run on a Mac using ‘parallels’ or similar software.)
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The main actions in using Options:
To achieve the best pattern of subjects, Options is very carefully designed so that you can:

•

enter the Students’ Names (either from the keyboard, or as a file from an Admin/MIS program
that already contains their names),

•
•

enter their Choices quickly (or accept them directly from home, over the internet),
analyse the data quickly and effectively (eg. to see how many groups are needed for each
subject; or to see which subjects can co-exist without disadvantaging any students; etc.)

•

experiment by building Option Block Patterns, either manually or automatically, and
automatically allocating the Students’ Choices to them, so as to quickly see the percentage
Satisfaction Rate for each pattern,

•

use a variety of tools to modify the Blocks and/or the Students’ Choices and immediately see
the consequences, to develop the best Option Pattern,

•

when a suitable pattern has been devised, Options can print out for you
(a) an individual timetable for each student, and
(b) a group-list for each teacher.
These sheets can include timetable details from TimeTabler, so that Students & Staff know
exactly when to go to each subject lesson. And you can ‘mail-merge’ a letter to parents.

These steps are shown on the Flowchart below.
The Tutorial demonstrates all these steps, and allows you to experiment for yourself.

Enter the Students’ Names.
You can do this from the keyboard, or you can
load in a file from your Admin / MIS software.
Enter their Choices quickly.
You can do it on your computer, or let them do it from home.
Options checks that they have followed the correct Rules.
Just click a button to analyse the data quickly.
Options draws a ‘Clash Table’ and gives you reports.

Build an Option Block Pattern on screen, either
manually, using your mouse, or
automatically, by clicking the Auto-Create button.
Options automatically allocates the Students’ Choices
to the groups, so you can quickly see the percentage
Satisfaction Rate for each pattern,
Use the Tools provided in Options to modify the
Blocks and /or the Students’ Choices. Experiment !
You can immediately see the consequences, to
develop the best Option Pattern.
After scheduling your timetable, add the lesson details
(manually or automatically) and send out:
(a) an individual timetable for each Student, and
(b) a Group List for each Teacher.

Options Manual
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Installing Options on a PC
Choosing a computer
Options will run on any standard PC with Windows XP, Vista, 7, 8, 10 or later.
It is an advantage to obtain the fastest computer you can. A colour printer is useful.
Although many people run Options on a laptop screen, we think a full-size screen is an advantage.
To see the Options screens at their best you should set your display to:
• 1024 x 768 resolution, • ‘small fonts (96dpi)’,
• ‘high colour (16 bit)’ or higher.
You can check or set these by following the route: Start->Settings->Control Panel->Display->Settings.

To install Options
1. Place the Options CD in the tray of your CD drive.
After a few seconds it will display a Menu from which you can select the program you want.
(Alternatively you can choose Start->Settings->Control Panel->Add/Remove Programs->Install)

Or, if you have been sent a web-download link, download and run the file (called Setup.EXE).
2. Then follow the instructions that appear.
At most steps you can just click on ‘Next’ (or you can cancel the installation).
At one stage it will ask you for the ‘Destination Directory’ where Options is to be installed.
The default that is supplied is C:\OPTwin
but you can change this if you like (click on ‘Browse’ to choose another directory).
If you name a directory which doesn’t exist, Options will make it for you.
If you are also installing the TOOLS on-line system, see the separate documentation on this.
If you have any difficulties in installing Options on your machine, please do not hesitate to contact
the HelpLine.
To install Options again or on another machine (eg. at home) repeat the same sequence. Please
note that full copyright restrictions apply to Options . Any breach of copyright will be prosecuted.
Options includes routines that allow you to transfer your data between a machine at home and a
machine at school, using just a USB memorystick etc (see page 10).
To uninstall Options:
Follow the route: Start->Settings->Control Panel->Add/Remove Programs.
In the lower box, find and click on Options, and then click on Add/Remove.

To run Options:
You can start Options in two ways:
Either:

Double-click on the red OPT icon on your desktop,

Or:

Click on Start, then Programs, then find and click on TT-Options in the list of programs.

If you have the full version of Options, make sure that you use: > Check for Updates regularly.
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The Options Menus
When you run the program you see the Options ‘desktop’ with the Main Menu titles on the
menu bar at the top:

As you click on each word with your mouse you get a drop-down menu.
These menus are shown here for your information, and they are explored during the Tutorial.
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Saving your data on a ‘memorystick’ or other media
It is important to get into the habit of making a Backup at regular and frequent intervals, as
• an external ‘backup’ on a USB FlashDrive ‘memorystick’ or another medium, see below,
• an internal backup in the AutoBackup Library, at FileMenu  AutoBackup Library,
[By default the autobackup period is 1 hour, but you can change this if you wish.]
Note : By default the program expects to do an external Backup to Drive C.
If you want to Backup and Restore to/from another drive (eg. a USB FlashDrive or Zip disc or your
hard-disc) you must first choose the device at FileMenu  Customize Backup & Restore.
Click on the yellow folder and then Browse to your Backup device, so that Options knows where it is.

File  OPT-Backup (copy to a USB ‘memorystick’ or other media)
This allows you to save your options data on one or more USB flashdrives or zip discs, etc,

•
•
•

for safety, in case your machine breaks down, and also
to transfer options-data from one machine to another (eg. to a machine at home), or
to archive data for use later.
1.

Insert your USB FlashDrive ‘memorystick’ (or similar) in your machine.

2.

Click on
then
to make a backup copy of your options files.
(Your Backup media now has a file called Op2data.bak with the current date & time.)

3.

If you want to be certain that it has worked, check it by clicking on ‘Verify’ on the File Menu.

We recommend that you use this method to make a safety back-up frequently, and
particularly at each major stage, preferably on a different Backup device each time.
USB ‘memorysticks’ can fail (or be lost) very easily!

File  OPT-Restore (load from a ‘memorystick’ or other backup media)
This is the reverse of OPT-Backup, and loads the data back on to your hard-disc.
This sets Options back to exactly the position you were in when you recorded the Backup.
ie. if you used OPT-Backup at 3.14pm last Monday, OPT-Restore takes you back to that moment.
Note: obviously this method erases the Options data-files that were previously on your hard-disc.
Make a Backup first, using OPT-Backup, saving to a different folder, if you want to preserve them !
1.

Insert your USB FlashDrive ‘memorystick’ in your machine.

2.

Choose OPT-Restore on the File menu to load the data from the backup device.

Used in conjunction with OPT-Backup, this also allows you to transfer data between two computers
running Options (eg. at home and at school), using just a USB memorystick, etc. See the HelpMovie.
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Support and Advice
Options is fully supported by expert HelpLine Support and Advice, both during the Tutorial and at
any subsequent stage of using the program in your school.
Click on
(while you are connected to the internet) to get direct access to
the 24/7 Help & Support Centre.
It includes an extensive Knowledge Base with Answers to all the typical questions you may have.
You can Browse the Knowledge Base or enter key words in the Search box.
You can download articles and ‘white papers’ on aspects of timetabling.
For specific questions that are not answered by the KnowledgeBase, you can submit a ‘Ticket’ to
our export staff for a detailed answer.
To get more details, click on the label that says:
New Users are given extra support, as needed, by the Gold-Start Enhanced Support programme.
More details at www.timetabler.com/gold-start.html
KnowledgeBase articles & email replies to Tickets are provided by Chris Johnson, Keith Johnson,
and Chris Knights-Branch supplemented by other expert Timetabling Associates during busy times.
Chris, Keith and Chris have over 80 years of timetabling experience between them, and have run
many courses.
Keith wrote the standard book on UK school timetabling, ‘The Timetabler’s CookBook’.

Web-site:

www.timetabler.com

or

www.timetabler.co.uk

In addition to the Help & Support Centre, there is also general timetabling advice on the web-site,
particularly for people who are new to timetabling.
The web-site includes:
• free INSET training packs on timetabling in general, (the Combing Chart, Conflict Matrix, etc),
• free downloads of the Tutorial Packs for TimeTabler and StaffCover.
Please ensure you register your e-mail address with us to receive news of Upgrades & new features.
(The web-site also includes free Physics materials and details of the readability of school science text-books.)

HelpMovies
There are HelpMovies for you to view and so learn about the software.

HelpScreens
Throughout the Options program there are interactive HelpScreens:

•

On any screen in the program, click on the Help button.
You will see another picture of the same screen.
On this image, click with your mouse on any button or part of the screen.
An explanation of that item is then shown to you.

•

Choose Help on the Main Menu bar, and then choose Help Topics.
Then double-click on any of the Book or Page symbols to read details about Options.

•

While on any Help screen, you can click on the
buttons to see the previous or next page.
You can do this repeatedly to read the entire Help documentation.

•

Click on the Index button to search for information.
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Preparing for the Tutorial
Please check these 2 things before you start the active part of the Tutorial.
First, make sure you have only the Demo-Data installed.
If you have just installed Options, this will happen automatically.
The Demo-Data consists of some sample data (see below) to enable you to try Options and
develop an Option Pattern, within a few minutes.
If the Demo-Data is not installed, but you want to go through the Tutorial, then go to
File  Demo data to re-install the data.
Similarly, if you change any of the Demo-Data so that it no longer fits the steps of the Tutorial,
you can re-set the data by choosing File  Demodata (on the File Menu).

Second, please note that on the first run through the Tutorial it is important to do only what is
described at each key step. Please try to keep carefully to this.
This is to ensure that you follow exactly the same path, so that what you see on your main
screen will be the same as shown in the illustrations on the HelpScreen.
Later you can choose your own route through the program as you wish.

Demo-Data
The Demo-Data is for a 7-form-entry school, about 200 students per year-group, divided into
2 half-year-groups in Year 10 (ie. Grade 10, aged 15 years).
14 ‘optional’ subjects are offered to each half-year-group in Year 10.

The Year 9 students were asked to choose 4 of these subjects in the ‘optional’ part of the
curriculum (as well as studying compulsory or ‘core’ subjects such as Maths, English, Science,
PSE, etc.). (In this example they were not asked to choose a Reserve subject.)
So the Option Block Pattern for Year 10 has 4 Blocks in it (in this Tutorial example).

The Demo-Data has been entered for 101 students in Classes 9C, 9L, 9J, 9K.
The rules were that they had to choose:

•
•
•

one modern language (from French, Spanish, German),
one technology subject (from Materials Technology, IT, Food Technology, Graphics),
and two more subjects from the list.

Options Tutorial
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Options Demonstration & Tutorial
1



Action!

To begin the Tutorial, run the program as described on page 8.
You should now see the Main screen with the Main Menu bar at the very top:

Screen 1
During this Tutorial we will look at some of these in detail.
If you click on any of these words on the Main Menu bar, a ‘drop-down’ list of items is shown.

2



Click on Help on the Menu bar at the top of the screen.
The Help Menu appears, as shown here:



From this list choose Help Topics, by moving your
mouse down until ‘Help Topics’ is highlighted, and then
clicking on it. (Or you can press the F1 key.)

Action!

3

Action!

(Or choose ‘WinHelp alternatives’, lower down the Menu.)

The Contents list for Options Help appears,
as shown below.

4



Action!

On this Contents List, click to
open the book symbol called
The Menus.
Then click and Display the page
called The Help Menu.
You will see an image looking like
the Help Menu shown above.

5



Action!

Follow the screen instructions to
click on each part of the image,
to see what each part does.
Friendly interactive HelpScreens
like this are available from every
screen throughout Options,
to guide you at each step.
To leave the HelpScreen just click on the program screen, and return to the program.

6



Action!

Click on File on the top Menu bar, then select and click on Exit Options.
Then click on Yes.
This is the only correct way to exit Options.
Then run the program again (as described on page 8) to re-enter it.
You can do this as often as you like.
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Overview Screen
7



<F2>

Click on the Overview button, so that the Overview Screen is shown:

Action!

This screen (at the right-hand side) shows you the 7 main steps in using Options.
It is designed to take you step by step through the process, working from left to right.
The 7 steps are described in outline on these 2 pages, and then in more detail later.

1

Populations

A Population is a number of students, to whom the same Choices are being offered.
You give each Population a name, as explained later.
eg. “Year 10 in 2001” or “Next year’s Lower Sixth” or “Next year’s Y10-Top-Band”.
You can specify up to ten Populations at a time, each of up to 2000 students.
Each Population can contain one or more ‘Classes’ (or ‘Forms’, or ‘Registration Groups’)
eg. a Population called “Next year’s Year 10” could consist of classes/forms 9A, 9B, 9Cg.
(These Class Names can easily be renamed for the new school year - for example these
three Classes could become 10X, 10Y, 10Z).

2

Subjects

These are the Subjects that are to be offered to this Population of students.
ie. each Population has its own list of Subjects.
There is a basic ‘default’ list of Subjects supplied by the program.
You can simply Edit the list so that it becomes your own list of Subjects for this Population.

3

Students & Choices

You need to tell the program which Subjects each Student has chosen.
There are 2 stages here:
1. The Names of the Students can be entered:
• either from the keyboard, or
• as a file from another program (eg an Admin System such as iSAMS or SIMS)
which already knows the names of the Students. This is the usual way.
2. The Subject Choices of each Student are entered (or loaded with the file above).
• either using the on-line TOOLS, so the students/parents use the internet at home, or
• manually, using the keyboard or your mouse.
The Tutorial shows you how to do this.
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4

Clash Table

The Clash Table is a large coloured Grid, plotting each Subject against every other Subject.
This Grid shows you at a glance 2 main things :
A. For each Subject:
• How many Students have chosen that Subject, eg. 36 have chosen Physics.
• The Names of these students.
From this information Options shows you how many teaching groups are needed for each
subject. eg. two groups for Physics (in the example above)
This helps you to calculate the cost of providing this curriculum.
B. For each Pair of Subjects:
• How many Students have chosen this pair of subjects.
eg. 28 have chosen both French & Biology.
eg. none has chosen Spanish & German.
• The Names of these students.
eg. only one person has chosen Drama & Graphics (Jo Smith).
This information can help you to decide the structure of the Blocks in your Options Pattern.
eg. French & Biology should be in different Blocks (in the example above).
eg. Spanish & German can go in the same Block without disadvantaging anyone.
eg. If I want to put Drama & Graphics in the same Block then I may have to counsel Jo Smith.

5

Designing a Pattern of Option Blocks

From this screen you can quickly design a set (or ‘Pattern’) of Option Blocks.
(These Blocks are sometimes called ‘Pools’ or ‘Columns’ or ‘Lines’).
The Blocks can be designed:
• manually, by clicking with your mouse, or
• automatically, by using Auto-Create.
This Tutorial shows you how to design the Blocks.

6

Assigning students to the Current Pattern

At the push of a button, Options will quickly:
• assign your Students to the Option Block Pattern that you have devised,
• tell you how successful it is (by showing a % Satisfaction),
• show you how big each Subject Group would be if you kept this Pattern,
• show you which Students are in each group,
• show you which Students will be disappointed if this Pattern is used,
• etc, etc.
Several Tools and Reports are provided for you to manipulate and fine-tune the Pattern.

7

Printouts, and Export to an MIS

When you have finalised a chosen pattern, you can then Print out (or email) the details of:
(a) an individual slip for each student, and
(b) a group-list for each teacher.
These sheets can include timetable details from TimeTabler, so that Students & Staff know
exactly when to go to each subject lesson. And you can ‘mail-merge’ letters to parents.
This method saves a great deal of time & confusion at the start of the new school term.
The rest of this Tutorial takes you through these 7 steps.
Options Tutorial

page 15

1
8

Populations Screen



Click on the First button on the Overview Screen, to see the Populations Screen,
shown below:

Action!



The screen shows that two Populations have been entered for you.
“Year 10 (TUTORIAL)” is the Current population.
(The name is echoed at the bottom of the main screen).
Make sure you use this one for the Tutorial.
It consists of 101 Students, in Year 9 at present.
Whichever Population is selected here, this is the one that is worked on in the remaining
6 steps.
Clicking on a row gives the Details for that Population in the boxes at the right-hand side.
In these boxes you could Edit an existing name, or enter new data, or allow students a
Reserve choice, but please do not change anything until you have finished the Tutorial.
You can choose to label the Option Blocks, either: A, B, C ... or: 1, 2, 3 ...
9



Action!

Classes button
Click on this button to View the names of the Classes (or Forms) of Students that make up
this Population.
For the Year 10 (TUTORIAL) Population there are 4 Classes: 9C, 9L, 9J, 9K.
There might be only one Class in a Population, or several.
eg. in a 6-form-entry school with the curriculum organised in half-year-groups, there might
be 3 Classes in each Population (eg. 9A, 9b, 9red).
The New, Apply and Delete buttons are used in entering or deleting data, but please do
not make any changes during this Tutorial, so that what you see will match these pages.
The Clone button allows you to experiment on a duplicate without altering the original.

10



Action!

Click on Close to leave the screen. Note: if you are asked whether you want to save
any changes, please ensure that you answer No.
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2
11



Subjects Screen
Now click on the Second button on the Overview Screen, to see the Subjects Screen:

Action!

To get more details about each part of the screen, click on the Help button, and then
click on each part of the image that appears.
In particular, look at the messages you get when you click on the
parts about :


12



Action!

Min. Group Size



Max. Group Size (see p. 37)



Max. Groups allowed



Faculty / colour

On this Subjects Screen, enter a new subject by following these steps:
• Click on the New button. This empties the Edit boxes (in yellow) at the right-hand side.
• Now type in the ‘Abbreviation’ box: Ph
• then press th e <Tab> key (next to the Q key), or click with your mouse, to move to the
next box, and then type in (for ‘Full name’): Physics
As usual you can change the details until it shows exactly what you want.
(If you want to escape and abandon it then just click on any row in the Subjects list.)
• When all is correct, click on Apply (or <Enter>) to confirm it, so it appears in the main list.
Enter other subjects in the same way, if you wish. Maximum number of subjects = 250.
Exactly the same method will be used on other screens later: ie. click New to start entering
new data, and then you must click Apply to confirm the entry.
If you try to enter the same subject again, Options will give you a warning message.
Options ‘holds your hand’ in this way, all the time.

13



Action!

Now click on Close to leave the Subjects Screen.
Options asks you: Do you want to save the changes? Yes / No/Cancel
The usual answer is Yes to save the changes on to the disk (but you can answer ‘No’ or
‘Cancel’ if you have changed your mind). Only changes saved on the disk are effective.
You will then arrive back at the Overview Screen.

Options Tutorial
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Action!

Students & Choices Screen
On the Overview Screen, click on the Third button, labelled Students & Choices,
to see the Students Screen:

Four Classes of Students have been entered for you.
Please note that in the free Demo version, the students cannot be changed.
The main screen shows the Students, with their surname, forename, and sex.
The column headed ‘Ch’ (Choices) shows how many Choices have been entered.
Notes and UPNs (Unique Pupil Numbers) can be shown if you wish (see the Customize Menu).
The name of the Class that you want to display is chosen at the top right.
As usual, the New, Apply and Delete buttons would allow you to Add, or Delete students from
the list, and you can Edit their details at any time -- but please do not do this during the Tutorial.
Choices row and Choices button
This area shows you this student’s current Choices, and allows you to enter / change them.
There are alternative methods, explained on pages 20–21. Choose the one that suits you.
Import button
The Students’ Names (and also, if you wish, their Choices) can be entered
• from the keyboard, or, more usually,
• as a file from a school or college Admin system (eg. SIMS, iSAMS, SEEMiS, etc) that
already contains their names. See the Help button and page 42 for more details.
Move button

allows you to move any Student to another Class or Population.

Sort button

gives you 4 ways to sort the students’ names.

Locate button

Options Tutorial

allows you to find any student quickly.
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Rules for Checking your students’ Choices
Clicking on the Rules button takes you to the Rules for Students’ Choices Screen:

You can use this screen to lay down Rules that your students’ Choices must follow (but please ensure
that you do not Apply and save any Rules while doing the Tutorial).
To apply a Rule, select it and its conditions in the boxes, then click on Apply (or press the <Enter> key).
You can also Suspend or Delete the Rules if you wish.
Here are some examples, of the first four Rules. Click on the Help button for more examples.
Example 1
Students must choose exactly 1 subject from Faculty 2.
If you had entered only Humanities Subjects in Faculty 2 (on the Subjects Screen), Options would
tell you if a Student does not choose any Humanities subject, or if s/he chooses more than one.
(The ‘Faculty’ does not have to be a real Faculty ...it is just a grouping of subjects for this purpose.)
Example 2
Students must choose 1 or more Subjects from Faculty 4.
If you had entered only Science Subjects in Faculty 4 (on the Subjects Screen), then Options will
tell you if a Student does not choose any Science subject.
Example 3
Students must choose no more than 1 Subject from Faculty 3.
If Faculty 3 contains ‘Drama’, ‘Performing Arts’, and ‘Expressive Arts’ then you will be told if any
student chooses two or more Subjects from this Faculty.
Example 4
Students must choose both these Subjects, or neither.
eg. if they choose to study BTEC-1 then they must also choose BTEC-2 as well. You will be told if not.
As you enter each student’s Choices (as described on the
next page), Options will automatically check your entries
against your Rules.
It gives you a report when a Rule is broken, like this:
Then you can counsel the student to make a better choice.
On the Students Screen there is a
Check button to make a global check at any time.
Any students infringing the Rules are then marked with a symbol :
page 19

Entering Choices : 1 – Manually
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If you collect the students’ Choices on paper forms then you can choose from 3 quick ways
for entering the Students’ Choices. These 3 ways are explained on this page.
On the Students’ Screen (shown on page 18), focus on the area showing the Choices for
the currently-highlighted student.
For example, this screen:
shows a student who wants:
1. History (Hi) as his highest priority 1st Choice,
2. French (Fr) as his 2nd Choice,
3. Drama (Dr) as his 3rd Choice, and
4. Art (Ar) as his lowest priority 4th Choice.
If you experiment here, when you click on Close to leave the screen, please ensure that you
choose No, “do not save”, so that the Demo-Data still fits the remaining steps of this Tutorial !
To experiment and change some of the students’ Choices : Select a Student by clicking on a
row, click on one of his or her Choice boxes (shown above), so that a drop-down list appears,
and then use your mouse to select one of the Subjects on the list. It’s as simple as that !
Page 39 explains an additional feature when entering Year 12 (‘6th Form’) choices, where
there might be 5 Blocks but students only choose 3 subjects, with the others being ‘free’ time.
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Action!

Still on the Students Screen, click on the button labelled Choices.
This new screen gives you more methods of entering the student’s Choices very quickly :

On this screen you can:
• use the drop-down boxes method as before, or
• just click on a Subject in the coloured Grid – this is usually the fastest way, or
• press the key of the initial letter of the Subject (eg. F for French).
As you click on each Subject, or press a key, Options moves you automatically to the next
Choice (as shown by the blue highlight above it). Try it !
And you can move quickly through all the Students by clicking on the Next Student button.
If you had chosen to include a Reserve Subject (page 16) then an extra box would appear.
These features give you a very quick & efficient way of entering a lot of data quickly.
Please remember, in this Tutorial, if you’ve made any changes to the students’ choices,
when you leave the Options screen via Close, please select No - do not save !

Options Tutorial
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Entering Choices : 2 – Students / Parents on-line
The TOOLS on-line system
This is an alternative way of entering your Students’ Choices, by using the on-line TOOLS system
(‘TimeTabler Options On-Line System’).
This is a system to allow parents/students to select their optional subject Choices on-line, using the
internet instead of the traditional paper method (see the previous page). This method means that you
don’t have to type the students’ Choices into Options – the parents / students do it for you.
If you choose to use this system, you need the assistance of your IT Manager to install the necessary files
on your school’s Web-Server. We provide the files and full documentation on this.
Or, easier, it can be hosted for you, see more details at : www.studentoptions.co
There are 3 stages to the TOOLS system:
Stage 1
After you have entered or imported your Students’ Names from your MIS (see pages 18 and 42) a screen
in Options allows you to print a letter to each Student/Parent which includes:
• a URL web-address eg. www.myschool.sch.uk/options
• an individual Username and Password/PIN.
Stage 2
At home, the Student or Parent
enters this URL on their computer
or smartphone or tablet to see a
Log-in Screen.
They enter their UserName
and Password/PIN to see
a screen like this:

The Student/Parent enters their
Choices and clicks on the ‘Submit’
button.
The system stores the result, and
sends them an email confirming the
Choices they have requested.

Stage 3
You can see [on a Control Panel] when all the Students/Parents have entered their Choices.
Then you can transfer the Choices to the Options program and proceed in the usual way.
On the Overview Screen (page 14) there is a button:
Clicking on this gives you access to all the documentation for the TOOLS system.
A key feature of Options is the speed at which the data is entered.
Once you have entered your Students’ Names (see pages 18, 42), and their Choices (see opposite and
above), and checked any Rules (page 19) then you can begin to analyse the data.
This is covered on the next page.
page 21
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Action!

The Clash Table
On the Overview Screen, click on the Clash Table button:
Options quickly draws a Clash Table for you:

The Clash Table shows each of the Subjects plotted against every other Subject.
Each cell of the grid shows the Number of Students who have chosen to study those 2
subjects. eg. in this table, 6 students want to study Drama (Dr) and French (Fr).
It gives you very useful information about the Choices of this particular population of students.
18



Action!

If you click on a Subject name, yellow ‘cross-wires’ are drawn to guide your eyes.
Diagonal cells
The coloured boxes on the diagonal show the Total Number of Students choosing that
subject. eg. 31 students want to study Geography Gg (see the Clash Table above)
You can use this to decide how many teaching groups should be staffed (see below).
Other cells
If a number is zero, no-one wants to do that pair of subjects, so you can safely put them in
the same Option Block. eg. the subjects CD and Fo shown above.
If a number is low, you may want to counsel those few students, to see if they have made
good choices, and for a definite purpose, to see if you can cancel a group altogether.
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Action!

Other information
If you click on any cell, you can view (and print out) the Names of those Students.
To do this, first click on the cell and then:
• either right-click with your mouse and choose ‘View these students’,
• or click on the Students button at the bottom.
The Combinations button allows you to enter any combination of subjects, and Options
will then tell you which students (if any) have chosen that combination.
The View missing button lists any students not yet included because they have not made
all their choices. Click on the Help button for more details.
You can Print and Export the Clash Table to send it to colleagues.
Last column at right-hand side
The column at the extreme right shows the Number of Groups that will be required to cope
with the number of students. It uses the Minimum and Maximum numbers per group that
you entered on the Subjects Screen (see page 17).
If it is in red (as a warning to you), it means that the Number of Groups that is needed is
more than you said were available (on the Subjects Screen).
The next step is start Designing a Pattern to try out.

Options Tutorial
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Go back to the Overview Screen and click on the 5th button labelled: Design a Pattern

Action!

You are taken first of all to the Library Screen.
This shows any Patterns of Option Blocks that have already been designed and stored (for
this current Population). (There is a limit of 120 Patterns stored at any time.)
The screen shows that 2 Patterns have been tried and stored:





There are 4 ways forward from here.
The 4 ways are listed below, but for the purposes of this Tutorial please choose only the
First one now.
1. If we want to View or Modify an existing Pattern, then

•
•

we select it by clicking on it, and
then we click on:

2. If you wanted to start a New Pattern, and design it Yourself, manually, then

•
•

you would click New, enter a New Name, and click Apply,
then click on:
Do not choose this method at present.

3. If you wanted to start a New Pattern, and design part of it Yourself, manually, and then
get Options to design the rest of it for you, automatically,

•

then you would start a New pattern as in (2), and click on:
Do not choose this button at present.

4. If you wanted to start a New Pattern, and get Options to design all of it for you, automatically,

•

you would just click on:
Do not choose this button at present.

Auto-Create will create a Pattern for you, automatically. See also pages 34-39.
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Please ensure that the top Pattern (“Y10 trial 1”) is highlighted (in blue) and then click on:

Action!

Options Tutorial
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Designing an Option Block Pattern
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You should now see a Pattern that was designed earlier, like this:

This screen allows you to quickly design an Option Block Pattern.
Please take care not change any Subjects in this Pattern at present.
The Blocks are labelled A, B, C.... or 1, 2, 3.... depending which you choose on the
Populations Screen. The maximum number of Blocks is 25 !
All the Subjects in a Block will be scheduled at the same time on the timetable.
The maximum number of groups per block is 80.
Note : You can increase or decrease the number of Blocks, and the number Groups
vertically in each Block (see the bottom left of the screen).
Adding or Changing a Subject
This is very easily done, but please take care not to change the Subjects from those shown
above, so that the next pages of the Tutorial will still make sense.
To change a subject:
• Click on any cell to see an arrow as shown here for Drama (Dr) :
• Click again to see a drop-down list of all your Subjects.


• Then just click on the Subject you want in this cell.
It’s that easy !
If you wanted to Delete a Subject, you’d select the dash ( _ ) from the drop-down list (at the
top of the list), and afterwards click on Redraw to shuffle up the lower subjects.
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Action!

Please check that all the Subjects are exactly the same as in the picture shown above.
Then click on the Assign/View Students button in order to move to the Assignments Screen.
Click Yes to ‘Do you want to Save?’, then Yes to ‘Do you want to re-assign students?’, then
No to ‘Do you want to Lock some students?’.

Options Tutorial
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This is the Main Screen in Options :

This screen allows you to manipulate & experiment with different Patterns, and immediately
see the effect on Groups Sizes, the Satisfaction Rate for the students, etc.
Cells
The coloured cells show the Subjects that were chosen at the Design stage on the previous
screen.
Each cell is in the ‘faculty’ colour that was chosen on the Subjects Screen.
Each cell shows:
• the Subject abbreviation (eg. Fr),
• the number of Students who have been assigned satisfactorily to this group,
Options does this for you automatically. (You can also show
separately.)
• the number of Students (eg. -2) who chose this subject but who could not be fitted.
Totals row
This row shows the total Number of Students that have been fitted in each Block above.
For a perfect solution each of these numbers will equal the total number of Students.
Auto-Assign
This button automatically assigns all the Students in this Population into the current Pattern,
taking account of their 1st Choice first, 2nd Choice next, etc.
Re-Design
This takes you back to the Design Screen (opposite page) so that you can alter the Pattern.
There are many useful Reports and Tool buttons that you can use on this screen.
They are described on the next 2 pages.
Options Tutorial
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REPORTS
At the right-hand side of the Assignments Screen there are 5 buttons which give you Reports:
Choice Order
This Report lists all the Students (in all the classes in this population) with the choices that
they made (ie. as you entered them on the Choices Screen).
In this Report, the Subjects are arranged in the order of the student’s Choices. ie. with their
1st choice shown first, 2nd choice next, etc.
Block Order
This Report lists all the Students (in all the classes in this population) with the choices that
they made (ie. as you entered them on the Choices Screen).
In this version of the report, the Subjects are arranged in the order of the Blocks.
ie. with the subject allocated to the 1st Block shown first, 2nd Block next, etc.
Subjects that have been fitted are shown in black and unfitted Subjects in red. ‘NP’ = Not Placed.
Group sizes
This Report tells you which Groups appear to be too big or too small. It also tells you if
you have added more Groups to this pattern than you said you intended to.
It uses the criteria that were entered on the Subjects Screen (page 17).
eg. if you specified a max group size of 20 for Technology, this report will tell you if any
Technology group is bigger than 20.
eg. if you said you were going to use only 2 French groups but you’ve put 3 groups in
the current pattern, this report will tell you.
Assignment by Subject
This is an alternative way of displaying the Current Pattern. It is useful if you want to analyse
your Pattern subject-by-subject rather than block-by-block. Click Help for more details.
Un-Assigned
This Report shows which Students have not yet
been satisfactorily placed in the current Pattern:
You can use it to help you decide whether to
add any more Groups to the current Pattern.
(To do this, click on the Re-Design button.)
You can use this Report to help you counsel students to choose a different subject,
one that will fit the current pattern.
Student Satisfaction
This shows the satisfaction rate for the Students.
eg. if 50 Students in a population of 100 Students got all their Choices, then the Student
Satisfaction rate would be just 50%. Obviously the aim is 100%.
Choice Satisfaction
This shows the satisfaction rate for the total Choices made by the students.
eg. if 25 Students each made 4 Choices (so that 100 Choices were made), and only 80 Choices
were satisfied, then the Choice Satisfaction rate would be just 80%. The aim is 100%.
Assigned to, or Missing from, this Subject
This shows the Students that have asked for, and have been successfully assigned to, or have
not been able to get, the Subject in the highlighted cell. (You can also right-click on the cell.)
Compare two Patterns
This button is on the Library Screen (page 23). Use the Help button for more information.
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TOOLS
Add
This button allows you to add a Student to a particular group.
You can also do this by right-clicking on the cell. See also the Shuffle button.
This button allows you to remove a Student from:
Remove
a
particular
Group,
or
•
• all the Groups to which s/he has been assigned.
You can also do this by right-clicking on the cell, to see the Right-click Menu.
To collect more than one student, hold down the <Ctrl> key while clicking.
Shuffle
If you want to move students between 2 groups of the same subject, then
click
on
one
of
the
Groups, and then click on the Shuffle button.
•
You will see 2 lists (of the 2 groups). If there are more than 2 groups of this subject, click on
‘Next group’ until you see the 2 groups you want. Drag-and-drop to move the student.
Bunch
If you have 2 or more Groups of the same Subject, then you can:
click
on
one
of
the
Groups, and then click on the Bunch button.
•
Options will then attempt to bunch the Students into the selected Group, at the expense of
the other group(s) of that Subject. If the other group(s) shrinks sufficiently, you may be able
to delete it from the Pattern, to give a less-expensive solution.
Equalise
If you have 2 or more Groups of the same Subject, then you can:
click
on
one
of
the
Groups,
and then click on the Equal button.
•
Options will attempt to equalise the Students between the groups, to give a fairer work-load
for the Teachers involved. (Like Bunch, it looks for moves between 2 or more groups of 2 or
more subjects.) However, often, equalising some groups will disadvantage other groups.
Split
If any group becomes too big then you can Split it into 2 (equal size) groups with this button.
Then use the Shuffle button to fine-tune the membership of each group.
More
This gives you two more tools: Sorting subjects and Merging cells.
Auto-Assign
This button assigns all the Students in this Population into the current Pattern, taking account
of their 1st Choice first, 2nd Choice next, etc. You can choose to Lock some students first.
You can use it to re-set all the group sizes if you alter them while using other tools.
Use the right-click Menu if you want to Lock a Group or a Block first:
Re-Design
This takes you back to the Design Screen (page 24) so that you can alter the Pattern.
Student Inspector
This takes you to the very useful Student Inspector Screen described in Appendix 1.
Use Reserves
If you have chosen to include Reserve Subjects (page 16), then click here to let Options
use the Reserves if they will give a better satisfaction rate.
TGNs (Teaching Group Names)
See Appendix 4 and the Help button for more details.
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A worked example
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Let’s look now in detail at this pattern, its problems and how to resolve them.
The current pattern you should see at this stage is (as at Step 24) :

Clearly there is a problem about IT in Block B, and about French in Block D. You can see
the groups are too big. (The Group Sizes button will also tell you this.)
There’s more than one way to solve this.
One way would be to add an extra IT group in Block B and an extra French group in Block
D, but this can be expensive in staffing.
A better way in this case is to add an IT group to Block D.
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Action!

Please do this now, by following these 3 steps:
1. Click on the Re-Design button to go to the Design Screen.
2. Click on the grey box for Group 6 under Block D.
(Click ‘Groups per Block’ to make it 6, first, if necessary.)
Click again to see the drop-down list of subjects, and choose IT.
3. Click on Assign/View Students and Yes (Save) and Yes (Re-Assign) and then AutoAssign now (leaving the two defaults of ‘Apply loosely’ and ‘No, reassign, don’t Lock’), to
come back to the Main Assignments Screen (above) with all the 101 students re-allocated
to this new pattern.
Can you see that it has solved the problems for both IT and French. Quickly!

The pattern you should now see is:

In the next section, 14 practical questions are asked about this pattern, for you to attempt
to answer, using the various Tools & Reports. The Answers are given as well.
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Worked examples 1 - 3
The next steps of this Tutorial explore each of these Reports & Tools,
in a problem-solving way, with a series of Questions with Answers.
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Action!

Q1. Which Groups are still too big or too small?
Answer 1
Just click on the pink

button at the top right.

It tells you that 2 Groups (Drama in Block B, and Art in Block D) are smaller than the
minimum Group-Size (15) that was specified for each of them on the Subjects Screen.
It also tells you that 3 Groups have been provided in this pattern for IT, whereas on the
Subjects Screen a maximum of 2 was specified.
Notice that on the main screen the problem groups are now highlighted :
At any time you can go back to the Subjects Screen to change the max/ min values, in
which case this report will change accordingly.
This report is for information only . . . it does not prevent you working on this pattern.

28



Action!

Q2. How many of these 101 students have been fitted?
Answer 2
Look at the right-hand side of this Assignments Screen.
It says that 96 of the 101 Students have got all their choices fitted OK.
This is 95% Student Satisfaction.
The 5 students that are not fully fitted are the reason why the totals in the blue bottom row
of the grid do not show 101 under each column.
When all the Students are fitted, all the totals will equal the number of students in this
population (101).
The other percentage shown on the screen is the Choice Satisfaction.
This may be a better guide to developing a successful pattern.
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Action!

Q3. Who are the 5 students who have not been fitted?
Answer 3
Click on the

button in the Reports section.

It lists the names of the 5 students that are not fitted, with information about:
• their Class/Form,
• which Subject choices have been fitted, and into which Blocks,
• which Subjects are Not Placed (NP), and which Blocks the student isn’t yet assigned to.
This gives you clues about which Subject you might need to add to a Block to solve this
student’s request.
Note: you can drag the smaller screen to any convenient position on the screen (just
drag with your mouse on the title bar).
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Worked examples 4 - 5
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Action!

Q4. The first person on that list is Nina Shaw.
What would you say to her?
Answer 4
The report given by clicking on
Nina Shaw is:

shows that the situation for

You can see immediately that:

•
•

she is Not Placed ( NP:A) to any subject in Block A, and
she chose French (Fr) but the current pattern does not allow her to study it.
This was because it was her 4th Choice.
Her higher Choices prevent her from getting French in this pattern.

If you are not going to change the pattern, you will need to counsel her to choose differently.
You can suggest:

•

either that she chooses another subject instead of French.
She must choose one subject from Block A.
For example, if the rules say she must study a Modern Language, she could choose
Spanish or German in Block A.

•

or that she puts French as a higher choice and chooses another subject for her
4th choice, one that fits the pattern.
If you wish you can enter her new choices and then see whether they fit & how big the
groups will be.

For the best way to do this, see the Student Inspector Screen described in Appendix 1.
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Action!

Q5. Who are the two people not able to do French?
Answer 5
Click on any of the 3 French cells in the grid on the main screen.
Then:
• either click on the Missing button,

•
•

or right-click with your mouse, and choose Students missing this Subject
or press <Ctrl M> (ie. hold down the <Ctrl> key while you tap the <M> key).

Any of these actions gives you a list of the Students not able to do this subject.
It is a sub-set of what you get from the Un-Assigned button.
Notice that the -2 in each of the 3 French groups refers to the same 2 students.
There are only 2 students unable to study French.
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Worked examples 6 - 9
Note: If at any stage you feel that you have spoiled the pattern, you can return to the
original pattern by clicking on Auto-Assign.
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Action!

Q6. Who are the 14 students doing Drama?
Answer 6
Click on the cell labelled Dr (Drama), in Block B. Then:

•
•
•

either click on the Assigned button,
or right-click with your mouse, and choose Students in this Group
or press <Ctrl G> (ie. hold down the <Ctrl> key while you tap the <G> key).

Any of these actions gives you a list of the Students assigned to this subject.
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Action!
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Action!

Q7. How can I get a printout of the 14 people doing Drama?
Answer 7
Use any of the steps described in the answer to the last question,
then click on the Print button at the bottom of the list.

Q8. Sarah Healey in 9C comes to discuss her choices.
What information can you display during the discussion?
Answer 8
Click on the Choice Order button to see her choices in order: 1st Choice, 2nd Choice, etc.
(Sarah is the second one on the list, in 9C.)

If Music (Mu) is still her least-favourite subject, and she wants to change it, you can discuss
the possibilities.
Click on the Block Order button to see how her choices have been allocated to the Blocks:

Her Music group is in Block C (see above) so you can offer her other Subjects from Block
C, unless they are too full. Keeping to Block C will not need any changes to your Pattern.
In this example (see the Main Screen), there is probably room in IT or CD, but Fo (Food
Technology) is probably full.
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Action!

Q9. If she decided to change her Subject Choices, what would you do?
Answer 9
Click the Student Inspector button, to see the screen shown in Appendix 1.
This shows all the information you need, and allows you to drag-and-drop with your mouse,
to change her subject Choices and Allocations. Click the Help button for more details.
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Worked examples 10 - 12
Note: If at any stage you feel that you have spoiled the pattern, you can return to
the original pattern by clicking on Auto-Assign.
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Action!
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Action!

Q10. How can you get a hard-copy of this pattern?
Answer 10
Just click on the Print button at the bottom of the screen.

Q11. What happens if you try to Bunch students into the Geography (Gg) group in
Block A ?
Answer 11
Click on the Gg group in Block A.
Then click on the

button, then Yes.

This Gg group grows in size, at the expense of the Gg group in Block D.
Notice that it also affect the Art groups (in Blocks A and D), because it is the students who
have chosen Art & Gg that are swapping between the groups.
The Gg group in Block D now consists of only 5 students.
It might be possible to counsel these 5 students to drop Gg, or to change their choices so
that they get Gg in Block A . . . in which case you could cancel this Gg group and so save
the staffing costs, or use the staff elsewhere.
You can now try Bunching the students the other way, into the other Gg group.
button with other subjects having 2 or more groups.
You can try the
eg. French (Fr), Art (Ar), IT, Fo (Food Technology).
is a more controlled way of moving students between groups (see opposite).
Click the Auto-Assign button if you want to get back to the original assignments.
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Action!

Q12. What happens if you try to Equalise students between the 2 Art (Ar) groups
(in Blocks A & D) ?
Answer 12
You may wish to click on Auto-Assign first if you want to get back to the original
assignments.
Click on one of the Art groups (Block A or Block D).
Then click on the

button, then Yes.

The 2 Art groups are equalised in numbers (as much as is possible with these students’
choices).This would usually be an advantage to the Art teachers.
Notice the damaging effect this has on the size of the Gg group in Block A.
Quite often, equalising one Subject in order to balance the teaching load on the staff, has
an adverse effect on the groups of another Subject.
Now try equalising Gg. How does this affect Art?
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Worked examples 13 - 14
Some final questions for you to tackle using the Tools in Options.
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Action!

Q13. There are 2 French groups in Block B. They are to be ‘setted’ into higher &
lower abilities. (Note: if there is only one group, use
to make 2 groups.)
Suppose you have printed out the list of students (see Question 7) to give to
the Head of Department, who then decides who is in the higher & lower groups.
How do you move the students to the correct group, so printouts will be correct?
Answer 13
You could use ‘Remove’ and ‘Add’, but here is a better way.
Click on one of the two French groups in Block B, and then

•
•
•

either click on the

button,

or right-click with your mouse, and choose Shuffle Students
or press <Ctrl S> (ie. hold down the <Ctrl> key while you tap the <S> key).

You are shown two lists, of the students in the French groups at present:

If the correct two French groups are not shown, click on ‘Next group’.
Highlight a student, then click on a blue arrow or drag-and-drop with your mouse.
In this way you can quickly move particular students between groups.
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Action!

Q14. Some students are doing Art (Ar) & Geography (Gg).
For example: Hurst, P and Johnson, D in 9C.
Because both Ar & Gg are in both Block A & Block D, the students can be
allocated as
A B C D
A B C D
Ar - - Gg
or as
Gg - - Ar
How can you change round the way they have been allocated?
Answer 14
This is basically the same as Question 13. Use Shuffle to move a student from one Art group
to the other. (Options will then move the student between the Gg groups automatically.)

This is the end of the step-by-step Tutorial. Other features of Options, including:
• Auto-Create,
• Individual Student Timetable printouts,
• Group Lists for Staff,
are explained on the next 17 pages.
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Using Auto-Create
As well as manually building up and adjusting a Pattern (using the Re-Design button), you can also get
the Options program to devise a Pattern for you, automatically.
This is a very powerful tool to get an initial Pattern, which you can then ‘tweak’ manually if you wish.
To create a Pattern entirely automatically,
1. Click on Design a Pattern to go
to the Library Screen (see page 23),
2. Click on the Auto-Create button:
3. You are shown the Auto-Create Screen:
You can customize Auto-Create by clicking on
the Customize button.
This gives you a choice of the Method and the
Constraint Factors that the program will use as
it develops a Pattern.
See below for more details.
4. Click Go :
The bars show you the progress, and up to four
Patterns are displayed, for you to save if you wish.
Auto-Create gives each resulting Pattern a name, but you can rename it if you wish.
Before starting Auto-Create you can set some Rules for the Pattern (see page 38).

Customize...
If you click on the Customize button
then you are shown this screen:

In most cases we recommend that
you keep to these Default values:

If you wish to change any of these values,
please read pages 36 – 39 first.
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Seeding Auto-Create
As well as getting Auto-Create to devise a complete Pattern for you, you can also begin a Pattern
manually, and then use this as a ‘Seed’ for Auto-Create to complete.
To do this,
1. Click on Design a Pattern to go to the Library Screen (see page 23),
2. Click New, enter a new Name for the Pattern and then click Apply,
3. Click on
4. Design as much of the Pattern as you wish (as described at Tutorial step 22),
5. Click on the Auto-Create button
shown at the bottom of that screen.
The choices you are offered are:



6. Choose the Seed button.
7. Then use Customize and Go as described on the opposite page.
Notes:
a) Your original ‘seed’ pattern can be stored as well as any new pattern(s) created by Auto-Create.
This allows you to review the ‘seed’ pattern, make a small change and then re-run Auto-Create.
b) The more groups you place in the seed, the more constraints you are placing on Auto-Create, and
so it is less likely it will find a good solution.
c) You can use a non-seeded Auto-Create to create a basic pattern. Then strip out any problem groups,
and use the remaining pattern to seed Auto-Create again. This time you may get a better solution.

Improve a Pattern
At steps 2 & 3 above, instead of creating a new pattern, you can choose an Existing
Pattern that you want to improve.
Then when you click on AutoCreate as at step 5 above, you can choose the Improve
button (on the screen shown) to see if this Pattern can be improved.



For example, if you had used ‘Standard’ search depth but would now like to see if some
of the groups can be moved using the ‘Deep’ search depth, to get a better Pattern with
a better Student Satisfaction. So you start with your existing pattern (which might be
good but not yet ideal) and ask AutoCreate to ‘improve it / explore variations’.
For example, you might create several quick patterns first at Standard depth, and then if you like the
look of one of them, improve it at Deep depth. Or if you have a new student join, or an existing student
change his choices, you can try improving the existing pattern rather than starting from scratch.
It works like ‘Seed’, except that Improve is happy to move around any existing group if it would improve
the satisfaction (whereas ‘seed’ is not allowed to move any existing group; it has to keep them all where
they were and can only add new groups to the Pattern).
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Customizing Auto-Create
Click on the Customize button (see page 34), to change how you want Options to work.
In most cases it is best to keep to the Default values.

1. Scanning Method (4 possibilities)
1. Thorough scan for 4 solutions (Default):
Time: with a large population this may take some time to complete.
This looks at many algorithms for creating Patterns and shows the 4 Patterns with the highest
% satisfaction, one of which will be the ‘best’ solution as found in method 2 below.
2. Thorough scan for 1 solution:
Uses the same algorithms (and time) as in (1) but displays only the ‘best’ solution.
Use it only if you don’t feel the need to decide between the 4 solutions of method 1.
3. Brief scan for 1 solution: Time: quicker. Can be used if methods 1 or 2 take too long.
Uses fewer algorithms to find an ‘acceptable’ solution ... not necessarily the very best.
These first 3 Methods can have different Constraints applied to them (see below), and different
Depths of Search (see below).
4. Feasibility scan (with no limits on the number of Groups):
Time: quickest. This will create a pattern for you that tries to fit all students choices, but without
any constraints on the number of Groups !
This shows a ‘perfect’ solution to the students’ choices if your school had unlimited resources !
You will probably get several small groups (you can try Bunch to eradicate some of them).

2. Depth of Search
There are 4 possibilities, which take
different amounts of time:
If you use ‘Standard’ depth initially then
you can use ‘Improve’ later (see page 35).

3. Speed of Search (3 possibilities)
The default is recommended unless (in a
very big school) the program is taking a
very long time (eg. many hours).

4. Constraint Factor (3 possibilities)
1. Use Maximum groups per subject
Level of constraint: lowest. Allows a subject to have up to the number of ‘max. groups’ specified on
the Subjects Screen, regardless of how small those groups might be.
eg. If you have said you will allow up to 3 Music groups, then if only 3 people chose Music, you
might get 3 groups each with only 1 student.
2. Optimize using Clash Table (Default, Recommended):
Level of constraint: medium. This allows a subject to have up to ‘x’ groups where: x = (Number of
Students taking this subject) ÷ (Max Size of a group of this subject according to Subjects Screen).
However, x is never allowed to be greater than the number of ‘Max. Groups’ specified on the
Subjects Screen. eg. if 60 students chose Physics, and Max students per group for Physics = 25,
then up to 3 groups are allowed on the pattern. However, if you set the Max Groups allowed for
Physics to be 2, only 2 groups would be allowed.
3. Use 1 group per subject: Level of constraint: highest. Each subject can have only 1 Group.
If resources are very tight, you could try this first to see how many students cannot be fitted.
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5. Maximum Group Sizes
There are 4 possibilities:
1. Apply ‘loosely’. (The default,
strongly recommended, see below),
2. Apply strictly (limit cannot go over by even 1 student).
3. Allow up to +10% (so if the limit is 20, then up to 22 students allowed in a group).
4. Allow up to +20% (so if the limit is 20, then up to 24 students allowed in a group).
The reason why we strongly recommend ‘loosely’ (the default) is:
if you said a max. of 20 students can take Art, then a group of 24 students might still be created in
the pattern, but it is highlighted in red to warn you that you need to look at this group, and decide
what to do:
• Can we allow more than 20 students after all ? (Perhaps it’s a very able group of model students ?)
• Can the group be split into 2 groups ?
• If we really can only allow 20 students, which 4 should we disappoint ?
• What Reserve Choices do those 24 students have – could some be satisfied by their Reserve ?
We take the view that ‘loosely’ is the best way forward, because it allows you to answer these
questions and to consider all the possibilities, whereas a ‘strict’ interpretation of the Max. Group
Size would simply say that 4 of those students could not be satisfied, with no human judgement
applied. That approach would be hard to justify to any parents who complained.
However, the stricter settings are available if you feel differently about how to handle group sizes.

6. Number of Blocks
Unless you are using the ‘Student Pathways’ feature (page 38), then you will usually want to leave
this as the default. ie. the Number of Blocks = (max) Number of Choices each student has made.

7. Try to Assign:
Assigning a sub-set of Students
You can perform ‘What if’s...?’ with
AutoCreate, so you can investigate what
solutions would be possible/available to you, if you omitted some of the students.
For example, in looking for a Pattern for the new Year 12, you may wish to (temporarily) omit students
who are doubtful about returning in the Sixth Form, to see what Pattern & Satisfaction could be
achieved for the students who you think are sure to return.
If you choose to use a Sub-set then you are shown a list of the Students so you can click to omit
the ones you wish:
(For safety’s sake, this choice
is reset at the end of each
session so that when you
restart Options next time, all
students will be ready to be
assigned again.)

Although AutoCreate ignores the red students in creating its pattern(s), once those patterns are
stored in the Library (at the end of AutoCreate) then any red students are brought back and assigned
against that pattern as best they can be (ie. the red students were not considered in creating the
pattern, but at the end we nonetheless fit their choices into the pattern where possible, so you can
see what the overall satisfaction is).
Patterns created via this method are marked in the Library with a double-asterisk**
You can also constrain the pattern by using Rules (see the next page).
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Rules for building a Pattern of Option Blocks
You can specify Rules that must be followed when building a Pattern of Option Blocks.
The Rules are applied whether you are working interactively to build a Pattern, or using Auto-Create.
Click on the Design a Pattern icon:
to go to the Library Screen (page 23),

and then click on the

button.

This takes you to the Rules for a Pattern Screen:

You can use this screen to lay down Rules that Auto-Create must follow. Select the Rule and its
conditions in the boxes, then click on Apply.
When you run Auto-Create, it will only display solutions that follow the Rule(s) that you have applied
(unless you insist on a ‘Seed’ that breaks the rules).
If you build up a Pattern yourself, interactively, you will be warned if you break any of the Rules.
Note : that applying any Rules can severely limit the possibility of finding a good solution.
You should only use a Rule if it is really necessary !

Some Examples of these Rules are shown in the box on the opposite page.

Even if you decide to apply a Rule, it is usually a good idea to also run AutoCreate without any Rules,
to see what the possible Satisfaction Rate might have been, and how much it has been affected by
applying your Rule. When you apply a Rule, Auto-Create usually takes longer to find a solution.
Note : When you start a new Pattern, its Rules are inherited from the last Pattern you viewed. This may
not be what you want, in which case go to the Rules Screen and delete the Rules for the new Pattern.
You can also Suspend a Rule, or all the Rules, and later Un-suspend them (see the screen above).
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Some Examples of the 7 Rules
Example 1
Subjects MUST be in the same Block.
For example, you want Art and Graphics to be in the same Block (for some good curricular reason,
perhaps for shared activities).
Example 2
Subjects must NOT be in the same Block.
For example, BTEC-1 and BTEC-2 must be in different Blocks, because they form a double option.
Example 3
Students must be placed in the groups CONSISTENTLY.
For example, if HSC1 and HSC2 form a double-option, and if there is more than one group of each,
then the students must be assigned consistently, so the groups are not mixed up.
Example 4
Subjects to be confined to specific blocks, via a grid:
Click on the Help button, to see 5 examples of using the control grid.
Example 5
Limit the Number of Groups in any block, for this Subject.
For example, if you only have 1 Music teacher, but 2 (or more) Music groups, you can use this rule
to say only 1 Music Group per Block. Similarly if you have only one ‘Food’ room.
Example 6
Limit the Number of Groups in any block, for this Faculty
Note: the ‘Faculty’ does not have to be a real faculty ...it is just a convenient grouping of subjects.
For example, if you are offering Spanish and French and Italian but you have only 2 MFL Teachers
to teach these 3 subjects, then you don’t want more than 2 groups of any MFL subject in any block.
Example 7
Use student ‘Pathways’. For example,
• some students are on a ‘Blue’ Pathway (with choices from one list of subjects), and
• other students are on a ‘Green’ Pathway (with choices from a different list of subjects),
but they have some subjects in a common block. For more details use the Help button.

Year 12 (‘Sixth Form’) Options

‘free’

In the UK education system, the students in Year 12 often do not have a full timetable. They have
Private Study or ‘free’ periods.
For example, the Options Pattern may have 5 Blocks (or ‘Pools’ or ‘Columns’) but each student may
choose to study only 4 or fewer subjects.
In this case you simply enter a Subject (on the Subjects Screen) called free.
Then you give each Student a full number of Subjects, by adding ‘free’ to their choice of subjects.
For example, in a 5-Block pattern, a Student might be entered as having chosen:
Maths Physics Chemistry free free
Then make sure that you add free as a subject to each Block of the Pattern.
To see an example of this in the Tutorial data, go to the Population Screen and choose the second
Population (called “Y12 L Sixth”). If you then visit the Students & Choices Screen, and the Design a
Pattern->View Pattern Screen, you will see how free has been used with these Year-12 students.
Note : there is an important and useful difference between:
• specifying ‘free’ as the subject (which will not give a warning Report), and
• specifying ‘–’ (no choice) as the subject.
This will give you a warning Report, via the Un-Assigned button on the main Assignments Screen,
to remind you that this student has not yet chosen a full set of subjects.
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Entering your own data - 1
Once you have completed the Tutorial, and have a good overview of the different parts of Options,
you will want to begin entering your own data.
There are 2 main ways you can do this:
1. Just leave the Tutorial data in place, and add your own data (as a new Population).
You can delete the Tutorial data later if you wish.
or
2. Completely delete all the data and begin from scratch.
To wipe out the data you can use File->Blank data on the File Menu.
Start with the Overview Screen <F2> (page 14), and work your way across the 7 buttons.

Step 1
First, on the Population Screen (page 16),
enter a new Population by following these steps:
• Click on New (so the Edit boxes turn yellow).
• Type in a name for your Population (eg. “Year 10 Options”).
• Select the number of Choices the students can make
(by clicking on the drop-down list).
• Tick the box if you want to let your Students have a Reserve Choice.
• Choose whether to label the Block A, B, C ... or 1, 2, 3 ...
• Click on Apply so that the Population appears on the list.
• Click on the Classes ... button.
• Click on Add, and enter the name of a Class in this Population.
Repeat this step until all your Classes are entered, then Close this sub-screen and
click Yes to save the data.
Then click on Close and Yes to close the Population Screen and save your data.
You can go back and edit it any time you wish (eg. to change Year 9 names to Year 10 names).

Step 2
Then go to the Subjects Screen (page 17).
• You are offered the choice of loading in a default list of Subjects,
to edit or add to. This is usually quicker than typing the whole list in.
• Or you can Import a file of Subjects from your main Admin System.
Click on Help for more details.
• To Add subjects click on New and enter the details (remembering always to
click on Apply after each one, to put the details into the list)
• To Edit an existing Subject, click on the Subject in the list so that its details appear in the Edit boxes,
then Edit the details as you wish, and remember to click on Apply to confirm them in the list.
When you have finished, click on Close, then Yes to save the new data.
As usual, you can go back later and Edit or Add if you wish.

continued...
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Entering your own data - 2
Step 3
Then go to the Students Screen (page 18), and use one of these 2 methods:
A. Use the ‘New, enter details, click Apply’ route that you used on
the other screens, to type in their names.
It is usually quicker to enter all their names first, and then add their Choices later.
or, better:
B. If you have a file of the students’ Names already entered in an Admin System
(eg. SIMS, iSAMS, SEEMiS, PASS, etc) you can import them electronically.
See the next page (page 42) for more details of how to do this.
(If you want to import their choices as well, click on the Help button for details.)
If you have any Rules about how your can choose subjects, enter the Rules as on page 19.
Then enter their Choices using one of the 3 methods described on pages 20-21.

Step 4
Then you can use the Clash Table (page 22) to analyse your data.

Step 5
Use the details on pages 23-27 and pages 34-39 to Design a Pattern,
either interactively or using Auto-Create.
Enter design Rules if you wish (page 38), but be aware that they may prevent a solution.

Step 6
Then fine-tune it to the needs of your students as described in the Tutorial, pages 28-33.
Counsel your students as necessary, see Appendix 1.
You can get a printout of the Pattern for consultations (pages 25-26, 43) and you can print
out (or email) preliminary Group Lists for your colleagues (see pages 49, 53).
When you have finalised the Pattern you can also ‘mail-merge’ letters to send to Students
or Parents (see Appendix 2).

Step 7
When you have finalised the Pattern, and when the timetable has also been finalised,
load in the timetable data, either automatically (page 44) or manually (pages 44-47),
and then print out:
• Individual Student Timetables, and
• Teachers’ Group Lists.
Then, if your MIS/Admin system supports the feature, export the Students’ Names for each
Group accurately and quickly, via a file from Options to your MIS (see page 50).
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Importing Students’ Names

(and even Choices, if known)

If you have your Students’ Names already entered in an Admin System (eg. SIMS, iSAMS, SEEMiS, etc)
you can export a file of the names, and then import that file into Options. This will save you a lot of time.
For full documentation on how to do it for these MIS, visit the KnowledgeBase in the Support Centre.
When exporting the data from your Admin System,
• You can save it as a ‘CSV’ (comma-separated-values) file, or as a ‘Tab’, ‘space’ or ‘xls-style’ file.
• You can save it to a local hard-disc or network server if Options is on the same machine or network
as the Admin System; otherwise save it to a USB FlashDrive ‘memorystick’ or zip-disk or CD, etc.
Then, in Options :
1. Go to the Students Screen (page 18) and (at the top) choose the Class into which you wish to
import the students.
to
2. Click on
see the Import Screen:

3. Step 1 :
Click on
and then
‘browse’ to steer your
way to open your file of
Students’ Names.
4. Select the correct
‘Delimiter’, and click
on Preview my File
to see the fields in this
file.

5. Step 2 : Choose the fields that you wish to import. Study the example above to see how this is done.
Class name field : If the file contains data for more than one Class,
you need to specify which Class to import on this occasion,
by entering the name of the Class you want to import now.
Other Classes in the file will be ignored for now; so repeat the
process later for each class.
(If ‘Class is field’ is set to ‘None’, all students in the file are imported to the Class chosen in step 1.)
Header is : The file may have a ‘header’ line(s) as shown above (AdminNo., Surname, etc). In the
box select how many of these lines should be ignored, so that you get the students’ names only.
(Note : If you also wish to import their Choices, eg. from a spreadsheet, click on the Help button.)
6. Step 3 : Click on Preview the Import to see the students’ names.
7. If the list is correct, click on the Import button to do the import. Click on Help for more information.
Notes:
i) Any Name that is too long for Options is truncated to 24 characters and shown in red so that you can
see them. You can edit them on the Students Screen if you wish. Any blank fields are shown in grey.
ii) If you haven’t imported the Gender, everyone is assumed to be the default sex pre-set on the
Customize Menu, so you may need to correct individuals, on the Students Screen.
iii) The UPN will be shown on the Students Screen only if choose this on the Customize Menu.
iv) If you forget to import the UPN you can import / add it later, see the Students & Choices Screen.
v) For importing the students’ Choices see pages 20-21 and www.timetabler.com/TOOLS.html
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7

Final Printouts

When you have got a
Pattern, then you have
a choice of Printouts:
Use the Help button on
each of these screens
for more details.

Then you will normally move to the timetabling stage so that you can schedule the lessons to particular
times of the week, using TimeTabler.
After you have finished scheduling, if you wish you can return to the Options Pattern in order to enter:
• the Teachers,
• the Times of the lessons,
• the Rooms.
If you wish you can also enter these details for
the ‘Core’ Subjects (eg. Maths, English, etc).
Entering these details allows you to print out:


Individual Student Timetables, to give to each student.
These can be printed as a timetable grid (showing teacher/subject/room, see page 48) or as as list.
These timetables can include details of the Core Subjects as well as the optional subjects.
See also TimeTabler for an alternative way of doing this, though if your MIS (admin system) can give
you these printouts, that may be the best way (after an export-import from TimeTabler to your MIS).
This is the most effective way of ensuring that each student gets their correct timetable, for a smooth
start to the term.



Group Lists, to give out to members of staff (see page 49).
These show the correct members of each Group, as well as the rooms and times.
They can be used as registration or attendance lists.

You can enter the data for all the scheduled lessons, either:

•
•

manually, or
automatically, using a file from TimeTabler.

After loading the data in automatically, you can
edit the data manually if you wish.
To start this process, move to this screen:
by clicking on:
and then on:

The automatic method is described on the next page,
and the manual method on pages 45- 47.
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A

Transferring your data from TimeTabler to Options automatically

This can be done quite quickly using a ‘Block Label’ (‘Block ID’) in TimeTabler to ensure that each
group in your Options Pattern gets the correct Teacher / Subject/Room/Lesson-Times during the week.
In TimeTabler
1. On the Customize Menu, ensure that

is ticked.

2. In the usual way, load the Schedule that you want to transfer to Options, and then use
go to the Class Timetable Screen (section F14 in the current TimeTabler Manual).
For each Teacher-team that you wish to label (see below),
Click on the relevant cell in the grid, and then
Click on the Details button (or double-click on the cell). This gives the screen
shown in F20 in the Manual, with the Block Label box showing at the bottom :

to

For Option Blocks :
For each Option Block teacher-team, enter its Block ID (a single letter or number) and then click Apply.
eg. for Block B in your Options Pattern in Options, enter B as the Block Labels in TimeTabler.
If necessary, look in Options or use the printouts from Options to ensure you use the correct ID.
(Note : you can also enter these Block Labels, before or after scheduling, on the Activities Screen.)
For ‘setted’ Core Subjects (eg. Maths sets, English set, etc.) :
In these cases you do not need to enter a Block Label.
However you should enter a Set Number for each group, on the same screen (and click Apply).
For ‘class-taught’ Core Subjects (eg. PSE is taught to the whole class as one group) :
In these cases you do not need to enter anything at all. Options will pick them up automatically.
3. Go to Export to ... TT-Options, and follow the instructions to save the data to a memorystick. During
the export you can get a printout of the Block Labels to check them.
In Options
1. If you haven’t already renamed your Classes, for the new year-group (grade) they will be in next term,
now is a good time to do it, via Populations Screen->Classes->Rename. eg. 9J becomes 10C.
2. Go to the screen shown on page 43, select automatically, and then continue.
3. Follow the instructions to load in the data-file (called TT-OPT.csv, from step 3 above).
If your Subject names in Options and TimeTabler do not match, you are shown a list. If so, you will
need to Edit the (‘Abbrev’) Subject name in either Options (page 17) or TimeTabler (section C6).
4. You are asked to select the Scheduling Name, as used in TimeTabler to schedule this Population
of students. There are 2 possibilities :
a) If the Scheduling Name is a single Class, eg. 10A, then
the program moves on to step 5.
b) If the Scheduling Name is a composite Class, eg. 10AB
in this example, then another screen is displayed :
so that you can specify which Classes in this Population
(eg. 10C, 10L) relate to 10A, 10B (the sub-sets of 10AB).
5. Click OK to complete the import and see a report.
If necessary, correct any errors and repeat the export-import.
Then : i) Go to ‘manual’ entry/edit (pages 45 - 47) and check the data have all loaded correctly.
ii) If you have some ‘setted’ Core Subjects (eg. Maths) then for a
fully-detailed Student Timetable you must assign the students
to the correct sets, as described half-way down page 46.
iii) If you want to change the period labels or add period-times, see step 1 on page 45.
Then go to the Printouts sections (pages 48-49).
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B

Editing or entering the timetable data manually

You can use these steps,
either : to edit data that has been loaded automatically from TimeTabler (see opposite) ,
or: to enter your timetable data manually after scheduling is completed.
There are 3 parts to the process:
1. Edit or set up the shape and labels of your school week,
2. Edit or add the ‘Core’ Subjects to the timetable grid (optional),
ie. subjects such as English, Maths, PSE, if they are not part of the Option Blocks.
If any of these Core Subjects is ‘setted’, then you must also assign students to particular sets.
3. Edit or specify the Lesson Times for the Option Blocks and the Core Subjects.
Each of these steps is described in turn, over the next 3 pages.

Step 1. Setting-up the shape and labels of your school week.
Go to the Printouts Menu -> Publishing -> Day & Period Labels:
You can then specify the days in your week,
and the periods in a day.
The default shows Mon, Tue, Wed, etc.,
but you can edit them to Day1, Day2, etc if you wish.
Other tabs or buttons allow you to:
•

Alter the way the periods will be labelled.
eg. 1, 2 or period 1, period 2, etc.

•

Decide whether there should be a second row of
labels, eg. for the times.
This allows you to have, for example:
period 1
period 2
etc
9.00 - 9.50
9.50 - 10.40

•

The Printout format button lets you choose the size
and font used for the title, and lets you modify
the width of the left-hand margin space.

You can come back and change any of these later.

continued...
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Manual entry or editing, continued ...
Step 2. Editing or Adding Core Subjects to the data
The program already knows about the Option Blocks, but it also needs to know details of the non-optional ‘Core’
Subjects, if they are to appear on the Student Timetables.
If you are only going to print out the Option Group Lists (page 49), you don’t need to do this Step 2.
There are 2 kinds of ‘Core’ Subjects :
a) ‘Setted’ Subjects If a subject is taught in parallel groups, rather like an Option Block containing only one
subject, then this subject is ‘setted’.
eg. if Maths is taught in 4 parallel sets, often with students coming from more than one class.
b) ‘Class-taught’ or ‘Form-based’ Subjects In this case a subject is taught on a whole-class (whole-form) basis.
eg. if the whole of 10A are taught PSE together.

a)

Setting-up the ‘setted’ Core Subjects (eg. like the Maths example above)
Move to the entry screen, either
and then Lessons & Times:
• via the Overview Screen <F2>, click on item 7 :
and then: ‘Manually’ and ‘Enter or edit details of Core Subjects that are setted’,
or
• on the Lesson Times Menu, choose: Core Subjects – Setted.

If you have loaded data automatically
from TimeTabler (page 44) the
Subjects will already be listed here.

This screen is very like the entry screen for Subjects (see page 17). Use it in the same way.
For each of these Core Setted Subjects, you then need to assign the students to the correct sets,
by clicking on the Assign Students to Sets button:
This takes you to another screen.
The quickest way to use the new screen is to :
1. Click on the Set 1 button,
2. Run down the column for the (first) Subject, clicking against the name of each student in Set 1,
3. Repeat for other sets, and then other subjects.
You can have up to 26 sets. For Set 7 and above, use the box at the right-hand side.
A bright red background warns you if you have entered a number greater than the number of sets.
You can click on a column header to re-order the lists :
• by alphabetical student’s name within a class, or its reverse,
• by students in ‘set’ order within each subject, or its reverse.
b)

Editing or setting-up the ‘Class-taught’ Core Subjects (eg. PSE)
Move to the entry screen, either
and then Lessons & Times:
• via the Overview Screen <F2>, click on item 7 :
and then: ‘Manually’ and ‘Enter or edit details of Core Subjects that are Class-taught’,
or
• on the Lesson Times Menu, choose: Core Subjects – Class-taught.
The entry screen is very like the one above, but simpler. Use it in the same way.
continued...
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Manual entry or editing, continued ...
Step 3. Specify or edit the Lesson Times for each subject.
Move to the entry screen, either

•

via the Overview Screen <F2>, click on item 7 :
and then: ‘Manually’ and ‘Enter Lesson Times’,

•

or on the Lesson Times Menu, choose: Lesson times & Teachers.

and then on Lessons & Times:

The ‘drop-down’ window at the top of this screen allows you to
choose from:

•

The Option Blocks A, B, C, etc that you decided upon in
your chosen Pattern (as on pages 24-25), or

•

The Core Subjects that you entered in step 2 above (see
page 45-46).

a) Choose a Block or a Subject in this top window, and then
click in some of the entry windows below to select the
appropriate Day, Period and Lesson-length, using the data
from your completed timetable.
If you have loaded the timetable data automatically from
TimeTabler, then this screen already shows the results.

b) When you have completed the Lesson Times for a Subject,
click on
to get this screen:

In the left-hand column, click on each Group in turn, and then enter or edit:
• The Teacher. Once you have entered a teacher’s name, it will appear on the drop-down list.
• The Room name / number.
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Individual Student Timetables
Move to the Printout Screen, either

•
•

via the Overview Screen <F2>, click on item 7 :
or on the

then Students’ Timetables:

Menu, choose: Students’ Timetables

This screen works in a very similar way to the printout screens in TimeTabler.
Click on the Help button for more details of each part of the screen.
You can go back and modify anything manually (pages 45-47), if the details are not correct.
Remember: untick the

when you are ready to print out more than 1 sheet.

The lessons are colour-coded: ‘Option Block’ lessons in blue, ‘Setted’ lessons in maroon, and
‘Class-taught’ lessons in black.
You can switch colour printing on/off via PrintoutMenu->Publishing->Colour printing. This is useful if
you want to photocopy black and white copies.
Click on

for even more control over the appearance of the printout.

To save paper, you can print more than one grid per sheet. For example, to print 3 grids per sheet,
placed so that they can be guillotined into 3 equal thirds, you can set the font = Arial 10pt or similar,
set ‘Students per page’ = 3, then Advanced->‘Vertical spacing between each student’ = 7, and
uncheck ‘Show main title’, then click Apply.
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Teachers’ Group Lists
Move to the Printout Screen, either

•
•

via the Overview Screen <F2>, click on item 7 :
or on the

then Group Lists:

Menu, choose: Group Lists

You are offered the choice of:

depending on how you want the lists shown.

This screen works in a similar way to the screen on the opposite page, so that you can adjust the size
of the font etc.
Click on the Help button for more details of each part of the screen.
As before, the title font and the left-hand margin width can be adjusted via PrintoutMenu->Publishing.
These printouts are useful as Registration or Attendance Lists or Mark lists. Together with the
Individual Student Timetables, they can ensure a neat and efficient start to the new term.
For the Exports see the next page.
For emailing the Group Lists to Heads of Subjects, for checking, see Appendix 2.
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8

Exports

You can choose from a
variety of exports:

1. For the TOOLS export see the PDF of the TOOLS documentation, at
http://www.timetabler.com/PDFs/TOOLS-Manual.pdf
2. The second item allows you to choose from a list:

and export it as:

3. The third item allows the export of a variety of
data, in .txt or .csv format. Most of the items are on the other menus on this page.
4. For details of the Mail Merge Letter to Parents, see Appendix 3.
5. Export to TimeTabler
You can export a completed Options Pattern
into an activity-batch in TimeTabler. When you
have the exported file from the menu above, in TimeTabler go to File Menu  Import from Options.
This asks you which Batch you want to import the option Blocks into. Once the Blocks have been
imported you can ‘tweak’ the blocks in the usual ways, on the Curriculum Diagram Screen.
6. Export to your MIS
Some MIS (eg. SIMS, iSAMS) allow you
to import all the data for your complete
Options Pattern, with the allocations for each student. This will save you a lot of time !
Clicking on the button shows a list of MIS that support this feature at present.
If your MIS isn’t on the list then please
ask the supplier to implement an import
(we can provide them with test files and
full file-documentation).

Select your MIS on the list,
and click on the ‘Read the
documentation’ button
to get full details.
See also page 54.
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Appendix 1

Using the Student Inspector : Counselling

This screen can be reached via
or via
on the Current Pattern Screen.
It is very useful if, after deciding on the Pattern that you are going to implement, some (few) students
don’t fit that Pattern, or else they’ve changed their mind, or perhaps they are new entrants to the school.

Then you can apply any
changes quickly, by
using drag-and-drop.



With this screen you
can easily discuss the
possible solutions and
counsel the student.



In this example, Nina
Shaw chose French as
her 4th Choice, but that
doesn’t fit the Pattern.
At the left-hand side you can see her Choices, in order. NP=Not Placed (French)
These Choices are repeated at the upper part of the right-hand side. Red indicates French is not placed.
In the Pattern of Blocks, the purple header shows that she has no subject in Block A, while the 3 brightyellow cells indicate the 3 Choices that she has got, in Blocks B, C, D.
The red French cells show where she could take French, if she changed her Choices.
If the student has made a Reserve Choice, it is shown at the top-right-hand side of the screen.
You can counsel Nina Shaw to :
• Either abandon French and choose a subject from Block A. You can double-click on any group to
show her who is in each group and where her friends are.
If she chooses a new subject you can just drag that new subject to her Choices using your mouse.
For example, just drag Graphics (Gra) from Block A to Choice 4 (Fr) at the top-right, or vice-versa.

•

Or she can keep French and change one of her other Choices. Again you can just drag the Subject
label with your mouse to make the change. For example, if she chooses to study Graphics (Gra) in
Block A, and abandon Technology (Te), then drag Gra from Block A to Choice 1 (Te), or vice-versa.
Or, to see the moves better, undo the Te allocation by dragging Te from Block B back to Choice 1 (Te).

In doing this, the program checks against any Rules that you have specified, and tells you of clashes.
To Review or Edit the current Rules, or to suspend them, click on :
To check how well your Students have followed the Rules, click on :
The list down the left-hand side initially shows all the students in this
Population, but you can select sub-sets by using the drop-down list:
Students with red problems (like Nina Shaw) are those that have not yet
got all their Choices in this Pattern. Students with blue problems (like
David Dixon, above) are those that have not yet made all their Choices.
Hover your mouse over any student to see any Notes & Comments entered for this student.
If the student is looking at the screen with you, and the notes are confidential, then un-tick here:
Click this button to see a Report of the Changes you have made during this session.
Save or Discard your changes: When you Close, you are always shown the effect of your changes in the
Current Pattern screen. When you Close that screen, you are asked if you wish to Save your changes.

Options Manual

page 51

Appendix 2

Emailing Group Lists to Heads of Subjects

When you have finished developing a suitable Pattern, you may wish to give the resulting Group Lists to
Heads of Department (HoDs), for their information and/or their approval, as follows:
A.
At Print  Group Lists (page 49) you are offered a choice of:
gives you the Group Lists arranged by Block (as before). ie. the Group Lists for each of the
groups in Block A, followed by the Groups in Block B, etc.
This is probably the best format for you to use to do any checking, but not the best format for a HoD
who may have to check several groups for his/her subject.
gives you the Group Lists arranged by Subject. ie. all the groups for the first Subject,
then all the groups for the second Subject, etc. See below for how to email these lists to HoDs.
For each of these choices you can use the
button to export individual files, ie. for individual
Blocks or for individual Subjects.
The files are Excel files, which can be easily emailed to colleagues (but see below). Each file-path includes
Labels & the Date, for example C:\OPTwin\Group_Lists\2016\BySubject\Oct19_13.09
B.
You can (optionally) enter details of your Heads of Department (Heads of Subject) in order to automate
and simplify the distribution of the Group Lists.
You can access this entry screen at any of 4 places:
• Basic Data  Heads of Department
• Subjects  HoDs
• Print  Group Lists  For Subject Heads, then
select Email  Setup  HoD email addresses
• Customize Menu  Email  Setup

This screen allows you to enter a formal name, a
familiar name and one or more email addresses
(use a semi-colon separator).
The formal name of the HoD will now appear at the top of the relevant printed Group List.
If the same person covers several subjects, then enter the data once and then click the ‘Copy’ button
and choose another Subject s/he is head of.
On this same screen use

to get a copy yourself, for your records.

C. Emailing Group Lists to HoDs
On the Group Lists Screen (page 49), as well as printing the students in each group as in A above, you
can also easily email them to the HoD for each Subject (for the HoD to check and return).
The email message to HoDs will look like this:
The top 4 items in the email are taken automatically from other
parts of Options (including part B above).
The default email message (shown here) can be changed at
CustomizeMenu  Email  Setup  Customize email text.
Once the details have been set up (in B above) this should
save your admin time.

To: Mr C Johnson
Re: Options Group lists for Info Technology
For: Year 10
Dear Chris,
IMPORTANT: Student Options, Group Lists:
Please find attached your Subject’s Group Lists.
Could you check and let me know if they are correct?
Thank you
Deputy Head
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Appendix 3

Mail Merge letters

You can send customized ‘Mail Merge’ letters to Students and their Parents, so that they know what
Choices they have finally been given.
In outline, Options  Export  Mail Merge File will export data for PLACEHOLDERS (see below) for
you to place in a letter that you type in Microsoft Word (or other word-processing software).
For example, if a letter is written with the following «PLACEHOLDERS» inserted within Word:
To : the Parent or Guardian of «FORENAME» «SURNAME»

Form: «CLASS»

Dear Parent or Guardian,
Options Choices
«FORENAME» has made the following choices:
1.
2.
3.

Choice
«CHOICE1»
«CHOICE2»
«CHOICE3»

Placed ?
«PLACED1»
«PLACED2»
«PLACED3»

in Block
«INBLOCK1»
«INBLOCK2»
«INBLOCK3»

If «FORENAME» wishes to change any of «HISHER» choices at this stage, then please note that «HESHE» can
only move to a subject in the same block as «HISHER» existing choice, and only if spaces are available:
Block «BLABEL1»
«GROUP1-1»
«GROUP1-2»
«GROUP1-3»

Block «BLABEL2»
«GROUP2-1»
«GROUP2-2»
«GROUP2-3»

Block «BLABEL3»
«GROUP3-1»
«GROUP3-1»
«GROUP3-1»

Then it will be printed out as:
To : the Parent or Guardian of David Walker

Form: 9A

Dear Parent or Guardian,
Options Choices
David has made the following choices:
1.
2.
3.

Choice
French
Art
Drama

Placed ?
Yes
Yes
Yes

in Block
B
A
C

If David wishes to change any of his choices at this stage, then please note that he can only
move to a subject in the same block as his existing choice, and only if spaces are available:
Block A
History
Art
Music

Block B
French
ICT
PE

Block C
Geography
Drama
Spanish

For more details, including an example and full details of all the «PLACEHOLDERS» that you can use,

•

Click on

•
•

See the Help files for Word or your word-processing software.

then on the Index tab at the top, and type ‘Mail merge’ to find 2 Help pages.

For a longer article that gives you more details, click on
and then type ‘mail merge’ in the Search Box:
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Appendix 4

Teaching Group Names (TGNs)

You can (optionally) use TGNs in 3 ways:
1. On Printouts
If your colleagues will recognise a TGN code and if you think they would find it helpful for identifying
groups, you can include TGNs on the following printouts:
• Group List printouts: – the TGN appears in blue, in the Group title.
• Student timetables: – click on the Advanced button and you can choose
“G (Teaching Group)” as one of your fields, as shown here:
• Pattern Design: – you can choose Show  Subject abbrev / full name or TG name.
• Student Choices: – you can choose Show  Block-Group-No. or TG name.
• Student Allocations: – you can choose Show  Subject abbrev / full name or TG name.
2. For exporting the Students’ Final Choices to some MIS
This can save a huge amount of time, where such an export exists.
For example, to iSAMS, or to Bromcom. (The export to SIMS uses a different method, without TGNs.)
For details see the relevant documentation for each MIS in the KnowledgeBase in the Support Centre.
3. For exporting the TGNs to TimeTabler (or you can enter TGNs directly, within TimeTabler).
The export file produced via Export  5. Export to TimeTabler  Export current pattern to TimeTabler
includes the TGNs so that TimeTabler can import them if you wish.

Entering TGNs
There are 2 ways of entering TG Names into Options:
A. Manually
On the Current Pattern Screen (page 25), click on
In each cell of the Pattern a blue ?-mark appears.

 Display Teaching Group Names (TGNs).

Click on a ?-mark and enter the TGN
for that group.
For example, 10A/Gr1 for this group:





B. Automatically
On the Current Pattern Screen (page 25), click on
 Assign Automatic TGNs,
and then select the format you want. Then click Create TGNs now.
You can specify the exact format by selecting from the drop-down lists on this screen:

You may need to experiment to get the best TGN format.
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Notes:

Other programs and information
Options is part of a suite of programs, with TimeTabler (the core program) and StaffCover.
You can download free Tutorial versions of TimeTabler and StaffCover from our web-site at:
www.timetabler.com
You can also download from this web-site free INSET training packs on aspects of timetabling.

For a fuller discussion of some of the issues in sorting out Options Patterns see:
Chapter 3 in Keith Johnson’s book: Timetabling : A Timetabler’s CookBook (ISBN 978-0-9561161-0-9)
It is now published by October ReSolutions Ltd.
There are more details of the book’s contents, with Sample chapters to read, on the TimeTabler
web-site at: w ww.timeta ble r.com / bo o k . h tm l
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